
Epilog Fusion Edge
Laser Cutter

Introduction: The Epilog Fusion Edge is a laser cutter capable of engraving a wide variety of 
materials and is capable of cutting through certain materials up to 3/8” thick. It is also 
equipped with a rotary table to engrave on round objects with a maximum diameter of 7.”
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Overview of Laser Cutting
Parts of the Laser

Control Panel
Here’s the various icons found on the touch screen.
1. Job List - This returns you to the list of available jobs from whatever 
menu you are in at the time.
2. Delete Job - Removes a job from the job list.
3. Settings - Accesses the machine settings (For staff only)
4. Available Jobs - The full list of available jobs that have been sent 
to the laser. If there is more than a single screen worth of jobs, scroll 
with your �nger to see those that were hidden. The most recently sent 
job will be typically at the top of the list.
5. Reset - If you have moved the laser head around any to test 
positioning for set up or if you want to cancel a job mid-project, this 
button will reset it to the machine home.
6. Focus - This allows you to set the depth of the laser bed for various 
reasons. Most typically used to adjust the height to match the material 

being used.
7. Red Dot Laser - Turns on a red dot so you can see where the laser is located. The red 

dot itself does not �re the laser.
8. Jogging - This allows you to move the laser left, right, up, and down around the bed. 

Typically used with center engraving.
9. Trace - This will trace a square outline around the borders of your overall design. This 

is used for visualizing where your project will sit on the material.
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Operating the laser
Setting up the machine
The following steps are to set up for a standard �at object engraving and cutting procedure. 
If you are engraving a cylindrical object, skip to Rotary Engraving later in the guide.

1. Turn on the laser using the switch on the bottom right side of the laser.

2. Once the machine boots up, tap the focus button on the touch screen.

3. If your object is too big to �t under the laser lower the bed by holding down on the 
joystick until there is suf�cient clearance.
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4. Once you have clearance for your object, place your object in the back left corner of 
the bed (or as back and left as you can if your object isn’t square.) Take note of the size 
of your object using the built in rulers on the bed. If your object is not square, you may 
need to use a ruler to get a more accurate sizing.

5. Tap the Auto Focus button on the touch screen and the laser will now focus itself to your 
object.

Engraving and cutting �at stock
1. In Corel Draw, set up your page to be the size of the object you’re working with. 
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2. Place your design where you would like for it to appear on the object. (For example, if 
centered to the middle of your page, then it would be centered to the middle of your 
item as long as their dimensions were matched.)

3. If you intend to cut through the material, set the vector path of your cut line to a 
hairline thickness.

4. Print your object by clicking on the printer icon on the toolbar or going to File > Print. 
On the print dialog, press Print.

5. The Epilog Dashboard will now open with your object. By default it will block off a 
region of the bed that matches the document size you created in Corel and your design 
should be placed where it was.
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a. Note, nothing in the greyed out region will print even if something appears there. 
However this region can be expanded if you change your mind on the page size or 
you need to adjust the placement later on. To do this, drag the pink border lines in 
include more in the usable area.

6. The design will enter in exactly as it was placed on the project in Corel Draw. If 
however you wish to make any adjustments to size, position, or rotation you can do that at 
this stage by clicking on the object and adjusting the points in the corners.

7. On the right side are your processes. This is where the software analyzes your design 
and separates out any engraving from cutting. There are two folder icons on each 
process, and the top one will pull up the material catalog.
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8. Select the material you’re using and the type of engraving or cutting you wish to do. You 
will have to set this for both the engraving and vector settings.

9. You can also rename your project in the top left which may be useful in later steps but 
is optional for the actual process.

10. Once you are satis�ed with the placement of your design, and you’ve applied the 
settings to your processes, click Print in the bottom right of the screen.

11. On the screen of the laser you should see your project appear at the top of the list.
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12. Close the lid of the laser and press the play button below the screen and your project 
will begin.

13. The project will move through the process list from start to �nish. If it doesn’t have one 
or the other, it simply skips that step in the process.

14. Once you are done with your project on the computer, click the Discard button in the 
bottom right of the screen to close out the project.

Rotary Engraving
1. Ensure there is adequate spacing under the laser. There should be several inches to 

start with. If there is not, tap the Focus button on the touch screen. Tap 3 and then the 
focus button. This will move the bed automatically to 6 inches down. You are also welcome 
to use the joy stick and lower the bed down manually.

2. Once there is suf�cient space, turn off the laser. This next step cannot be safely 
completed if the machine is on.
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3. Take the rotary table from the opening at the bottom of the laser and place it into the 
back left corner of the laser bed.

4. Plug the cable into the port on the right back corner of the laser.

5. Turn on the laser.

6. Measure your object in terms of height and width. Note these for later.
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7. Place your object on the wheels of the rotary table. If the right most wheels don’t touch 
or are too far in from the edge of your object, pinch the two arms on the right side and 
slide the wheels until your object is sitting with both ends on a set of wheels.

a. Note, sometimes there is a pinch roller on the left side. This can help with rotation 
sometimes, but can get in the way depending on the orientation of the glass. If it is 
present, press the left side to open it, and put the lip under the roller.

8. Set the level onto the object. Turn the knob on the right side left or right to raise or 
lower the one end of your object until the bubble on the level is just touching the right line 
as shown in the picture. This will level the object out to the arm of the laser itself.

a. Alternatively you can visually align the edge of the object to the line on the back edge 
of the laser as a way to level it.
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9. Take the sizing bar out of the storage tray and set it on the left side of the laser head 
with the brass end on top.

10. Press the focus button on the control panel. Use the joy stick to raise or lower the bed 
so that the tip of the sizing bar is just touching the surface of your object. DO NOT USE 
AUTO FOCUS. Remove the sizing bar and set it back in the tray for storage.

11. Press the red dot laser button on the touch screen to turn the laser pointer on.
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a. Note: If using glass as your material, it can be helpful to apply some blue tape to the 
surface of your object to help see the red dot. Be sure to remove this before running 
the project.

12. Use the jogging function on the touch screen to move the laser left and right to align your 
home position (the red dot) with where you wish to start your object from. There are two 
methods to this approach and they’re listed in detail below under the section for Center 
Engraving.
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13. Once your location is set, press the Centering Point button to lock that position in.

14. In Corel Draw, create a document where the width of the page is the height of your 
object and the height of the page is the width of your object. Then click OK.

15. Set up your page with whatever design you’re doing. Then rotate the design 90 
degrees left or right so your design matches the orientation of the object in the machine.
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16. Print your �le using the icon on the task bar or through File > Print. Press print on the 
dialog box that pops up.

17. You’ll then be taken to the Epilog Dashboard where your design will appear.

18. On the right hand side under Processes, click the upper folder icon to select the 
material you’re going to engrave on and apply those settings. If you are engraving at 
400 DPI or lower, choose a dithering option like Jarvis from the drop down.

19. Click on the advanced tab at the top side. In that section you’ll toggle “Rotary 
Engraving” on. It should then show you your page size you listed in Corel Draw.

20. In the left column you’ll choose your centering option. The speci�cs of these are listed in 
the section for Center Engraving.

21. Once these settings are applied you can press Print.
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22. Your job should appear on the touch screen on the laser.
23. Close the lid of the laser, turn on the fans using the switches by the computer monitor, 

and press the play button below the touch screen.

Center Engraving
Center engraving is a process by where you de�ne a home position for the laser. There are a 
few different approaches to center engraving and their placement is dependent on the 
design you want to use.
Typically you’ll be doing this in one of two ways. If you want to align your design to the 
center of your object, you’ll use the “Center-Center” option. This looks at the center of your 
design and places it at the red dot you de�ned using the jog feature on the touch screen.

If you want to align the design a certain position away from an edge, say the rim of a cup, 
then you would use the “Left-Center” or “Right-Center” method depending on the orientation 
of your object. Here you would de�ne your red dot at the top of the design and your design 
will engrave from that point outwards.

Neither option is more correct than the other inherently, but you can utilize one over the other 
based on your intended outcome of the object.
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Using the Camera
The laser cutter is equipped with an overhead camera that can show you on the computer 
where objects are positioned and allow you to place your design onto easily misshapen or 
size restricted materials. The key thing to realize with this is the cameras are located at 
approximately 12” x 8” and 12” x 18” on the bed. The further from these points you get the 
less accurate the camera can be. In particular the far corners of the bed do not 100% line up 
with your design visually on the screen.

For this reason, it’s best to use the camera only when required for an unusually shaped 
material and you should place the material directly under one of the two cameras to do so. 
This will ensure the most accurate representation of your object on the computer.

1. Place your object on the bed underneath the camera. Jog the laser to the object and 
then auto-focus the laser to your object.

2. On the Epilog Dashboard, �nd the option for “pan” on the left sidebar and select that.
3. There is a checkbox to turn on the video feed. Click this to turn on the camera.
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4. A live feed of the bed will now appear on the screen.
a. Note, if your object is rather deep (for example a box), then the top of your box will 

be in focus with the laser, but you may see more of the bed and interior of the laser 
than intended. For this instance, try to ignore everything that isn’t showing directly on 
the top side of your object.

5. You can drag, rotate, and resize your design to �t onto this object. 

6. Apply any settings through the processes menu as usual and print your object.
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Performing a test cut
You can use a vector cut path to trace the outer bounds of your design around your object. 
This is a useful tool when checking whether your design will �t into an appropriate area on 
oddly shaped object. (You can use the camera for this as well in certain instances, but you can 
be more accurate with this approach. Though this method does take more effort, it will be 
more accurate on objects not placed directly under the camera.)

1. In Corel Draw, create a vector path using a shape or pen tool slightly outside the 
edges of your design. You want this to be bigger than your design, but not by much.

a. Note if your design has a cut line already, you can skip creating a second cut path and 
just use this design as your vector.

2. Print your job and open it in the Epilog Dashboard.
3. From the dashboard, set your engraving process, if any, to off. Set your vector speed 

to 100 and power to 0, then print your job.

4. Leaving the lid to the laser open, turn on the red dot laser using the touch screen.

5. Press Start on the laser.
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6. Watch the path the red dot follows. If this is not where you intended your design to be, 
either move the material to match, or adjust the placement on the screen and print again.
a. Note: Center engraving can help with this process, but can also complicate the project 

some as well. See the section on Center Engraving for more information.
7. If you like the placement of your design, return to the Epilog Dashboard and remove 

the vector process (unless you were tracing with your actual cut line), turn your engraving 
process back on, and run your job as you normally would for the project.
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Advanced
Trace Bitmap
Objects that enter into CorelDraw may not be the best quality, or may have elements that are 
not ideal for the laser process. One solution to this can be the Trace Bitmap function. This 
process will scan the image and attempt to make a vector version of it. This can be useful to 
create unique cut lines from a piece of clipart in a JPG or PNG format, or to remove an 
unwanted background that would appear on the �nished piece.
Note that the process can work very well, but the worse quality the image, or the more detail 
is in it, you may have less luck with the overall process. This will describe how to create an 
image using a simple piece of clip art. You may need to tweak and modify your design to get 
the best output.
1. With your image selected, click on “Trace Bitmap” on the toolbar. Under this you’ll look 

for Outline Trace and then select the most appropriate option. Detailed logo typically 
works when you’re unsure which to use.

2. This will then display a preview with your original image and with the vectorized version, 
along with some adjustment sliders.

Laser - Fusion Edge - 19



3. The sidebar gives you some sliders you can adjust. This allows for changes to detail, 
corner smoothing, and the overall smoothness of the design.

4. Under the Remove section, if you have any internal areas that haven’t had the 
background removed, choose “Color from entire image” to remove those.

5. It is recommended you check the box for “Delete original”, but it isn’t required and may 
be best left unchecked if you plan to try this process multiple times with different results.

6. If your image has a lot of colors, or even just appears with a few patches of color, you 
can click the Colors tab. This will show all the colors in the design. It is recommended you 
get to as few colors as you can manage for the process to simplify the overall design.

7. Once satis�ed with the process, you can click OK to get your �nished design.
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Using Dockers
Dockers are the set of tools on the right sidebar of the screen in Corel. The library default 
includes �ve though there are many under Window > Dockers you can add for a variety of 
features. This section will cover the �ve we typically provide.

Properties
This docker will give you the ability to modify a particular item. There are too many variables 
to cover in here, but the main items are desribed below. Here you have the ability to change 
the �ll of an object. You’ll most likely want to work in RGB for this process. Note that anything 
that is listed as R0,G0,B0 will engrave at full power and anything that is R255,G255,B255 
will be ignored in the �nal engraving.

You also get the ability to change the outline of an object. You can tweak the appearance of 
the outline by how thick it is, what the line looks like, and where along the vector path the 
outline sits. Hairline is the outline setting used to cut through an object fully.

The other main area is the ability to modify the color and outline settings on text. While the 
font choices appear on the top toolbar, modifying the color and outline settings can be 
harder to manage and those settings are here under Properties.
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Objects

The objects docker lets you see every piece of text, shape, and line you have within your 
design. These are organized into layers. It will put everything into just one layer unless you 
create a second layer.

One of the most useful features within this is the ability to prevent a layer from printing. You 
can use this feature to create a layer �lled with guides to help you better set up your design 
without using them in the �nished printing. For instance, creating a circle to visualize where 
your design sits on a round coaster without engraving or cutting anything along the border of 
the coaster itself.

To do this, hover over an entire layer and click the printer so that it becomes crossed out.

Align and Distribute

Align and Distribute are two very useful features that let you better arrange your objects. The 
top section shows the ability to arrange objects by the left, center, right, top, middle, or 
bottom of all the selected objects.

The next section down details how they will align to each other. These will align them to each 
other, to the edges of the page, to the center of the page, along a grid, or to a speci�c point 
you specify on the page.

Distribute lets you space your objects in relation to each other either along their edges, 
centers or the spacing between the objects themselves.

The second section allows you to distribute them either according to the bounding edges of 
the outer most selected area, across the entire page itself, or with a speci�ed distance 
between the objects.
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Shape

Shape is used to connect different pieces together to make one solid object. There is a docker 
for this giving you a drop down menu of features.

For a quick action, these tools are also on the toolbar when more than one object is selected.

These are most commonly used to merge shapes together into one object, but also are used to 
cut one object out of another to create a hole.

Step and Repeat
Step and repeat is similar to distribute except where distribute moves around already 
created objects, step and repeat creates the objects as well as distributes them in one action.

You can distribute either horizontally or vertically, or both together. The distance listed is the 
gap between each item and can usually be set as low as .125”. If you just want to go in one 
direction, set the direction you don't want to move to “No offset.”
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Color Mapping
One useful feature of the laser system is called color mapping. This is where you can apply 
different settings to differently colored items in your design. Perhaps you want one part of 
the design to engrave deeper than another, or maybe you want to score one cut line and use 
another to also cut through the material.
For this process in Corel Draw you’ll need to apply different colors to the different parts you 
want to treat differently. For instance in this example, there are two hairlines.

Without color mapping these would both cut through the material. But with color mapping we 
can set the one line to score into the surface while the other cuts through it.

1. After sending your project to print, click on the process you wish to split up.
2. Click on the “Split by: Color” option and your project should split into parts for each 

color.
3. You can merge these back together should you need to by clicking “Merge with:” and 

selecting the appropriate option.
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4. From here you can apply any amount of settings to your multiple processes either by 
importing a material type or by manually applying settings.

5. Print your job as normal.
6. Do note, that the laser will perform the job from the top down in the processes menu. 

It’s advised that whatever process is going to cut through the material completely be 
reserved for the last position just in case any part of it were to shift after being cut out.

Dithering
When engraving with a lower DPI or with photos, it’s best to use an image dithering option 
found under the raster settings. Dithering is the dot pattern produced by the laser. This can 
affect the overall look. For clip art and single color graphics, standard is �ne. Standard 
produces a fairly uniform dot pattern over the image which may not be desired with a photo. 
However, when engraving a photo or an icon with a lot of variable grays, other options like 
Jarvis can be preferred. Jarvis is an all around good option for photo engraving.
These are the various options and what they do.
• Standard - The default for most text and clip art 

applications at 500 DPI.
• Floyd-Steinberg - Has a wave like pattern to it that 

can be ideal for photos with a lot of detail.
• Jarvis - A good general use option for photographs.
• Stucki - A similar pattern to Jarvis that is nearly identical in outcome.
• Bayer - Produces a cross hatching pattern which is lower resolution but very stylized.
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Testing new materials
When using a new material that is not 
found in the materials list, or if you 
want to modify an established setting 
for a different effect, �rst check with 
Maker Studio staff to see if they have 
experience with that material. If not, 
follow these steps to �nd the right 
settings. This guide can also be used 
to modify the settings of an existing 
known material for personal 
preferences.
1. Choose a material from the chart that seems similar to your object, either in thickness, 

density, or stiffness. Use these settings as a baseline.
2. In CorelDraw, add a small bit of text to a design if you’re �nding engraving settings and 

a small rectangle if you’re �nding cutting settings. You will engrave or cut this design in 
multiple times while experimenting with settings. It can be helpful to engrave in the 
settings you used so you can reference and compare to past experiments.

3. Engrave this design in using the settings from your similar material. After the job is 
complete, examine your material and see if it had the desired effect. If not, adjust 
settings and try again. Even if it looks good the �rst time, try a couple variations to see if 
you can really get it looking great.

4. When adjusting settings, if you want the design to engrave more, increase the power 
and/or decrease speed. If you want to engrave less, increase speed and/or decrease 
power. Similarly, if your design didn’t cut all the way through, increase the power and/or 
decrease speed. If your design cut through but perhaps burned too much of your edge 
away, increase speed and/or decrease power.

5. Repeat this process multiple times until you �nd a good balance between speed and 
power.

6. If this is a brand new material, write down the settings and provide them to the Maker 
Studio staff to update our materials catalog.
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Metal shear/Corner rounder
The laser is incapable of cutting through metal. For that reason, we have a metal shear that 
can cut thin metals along straight lines. When cutting metal with the shear, do the best you can 
to maximize the size of the scrap cut off by cutting in a way that would save the largest sizes 
of metal before cutting small pieces off.

1. Raise the arm of the metal shear and place the sheet of metal on the bed against the 
ruler.

2. Slide the sheet under the blade and align the edge of your design with the edge of 
the bed.

3. Give consistent pressure as you push the arm of the metal shear down to cut through 
the metal.
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4. Repeat on all four sides.
5. If desired, we can round the corners with a punch.
a. Place your cut metal into the corner punch. Ensure your design is pressed back as far as 

it will go on both sides of the die punch.

b. Press down on the handle.

c. Repeat until all corners have been rounded.
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For Staff Use
Adjusting the focus gauge
The focus gauge is very precisely set. In the event that the end loosens and it gets out of 
alignment, the total length of the rod should be 86.1mm. Alternatively you can auto focus to a 
�at object, loosen the end of the gauge and then manually adjust the gauge to match the 
gap created through autofocusing.

Cleaning
To clean the laser head follow these steps.

1. Loosen the two thumb screws on the front panel of the laser head.

2. Unplug the hose on the left side of the laser head.

3. Take the focus gauge out of the storage tray and locate one of the holes in the ring 
surrounding the laser.

4. Insert the focus gauge into one of these and turn it left to loosen.
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5. Once loosened, swing the front panel out of the way and remove the laser head.

6. The back of the lens can be cleaned using a lens cleaning wipe by reaching down the 
tube from the top. It may be useful to use a cotton swab to help get the wipe all the way 
down the tube to the lens.

7. To clean the front of the lens, loosen the screw cap on the bottom of the head.
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8. Unscrew the brass plug. If it is stuck, use the small screwdriver in the maintenance kit 
and insert it into the brass plug to loosen this and remove it.

9. Remove the outer tube and spring and set them aside.

10. Unscrew the inner shroud and set aside.
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11. The front of the lens can now be reached for cleaning. It may be useful to use a cotton 
swab to help get the wipe all the way down the tube to the lens.

12. Reassemble by inserting the inner shroud and ensuring there is no overlap visible in the 
hole.

13. Put the spring inside the outer tube and then insert the laser head back into the outer 
tube.

X
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14. Align the holes up and insert the brass plug into the hole. Tighten the brass plug by 
hand. Ensure the outer tube can slide up and down once inserted.

15. Screw the outer shroud back onto the end of the laser. Reinsert it into the laser head.

16. Using the focus gauge, tighten the nut to reattach the laser head.

17. Reconnect the air tube to the brass plug.
18. Loosen to the top screw on the top of the laser head.
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19. Remove the mirror from the laser head assembly. Clean the mirror with a lens wipe and 
reinsert it. Tighten the top screw.

20. Close the front panel and tighten the thumb screws.
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Emptying the tray
As small pieces of material are cut out and fall through the bed, you’ll need to clean out the 
tray under the bed.

1. Taking the hex screwdriver, loosen the three screws on the front panel. (The top left 
screw was inserted incorrectly at the factory and should be left alone for this process.)

2. Pull down on the front panel to remove it.

3. Slide out the inner tray and empty it’s contents into the trash. Try to sweep out any 
extra bits you can that fell out of the tray using a brush.
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4. Insert the tray back in. A pin is located in the center of the back and should be aligned 
to allow the tray to properly sit.

5. Align the pin on the front panel with the hole at the top of the panel area, and then 
slide up to lock in place.

6. Tighten the three screws to secure it.
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